
A Presentation of TeachUcomp Incorporated.
Copyright © TeachUcomp, Inc. 2016

TeachUcomp, Inc.
…it’s all about you

Advanced
Project

Sam
ple

- fo
r e

va
lua

tio
n p

urp
os

es
 on

ly!



2Advanced Project©TeachUcomp, Inc.

Advanced Project

TeachUcomp, Inc.
Phone: (877) 925-8080
Web: http://www.teachucomp.com

Copyright:

Copyright © 2017 by TeachUcomp, Inc. All rights reserved. This publication, or any part thereof,
may not be reproduced or stored in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, recording, photocopying, or otherwise, without the express written permission of
TeachUcomp, Inc.

For PDF manuals, TeachUcomp, Inc. allows the owner of the PDF manual to make up to 2
additional copies of the PDF manual that the owner may place on up to 2 additional non-shared computer
hard drives for ease of use when using the accompanying DVD-ROM tutorials. TeachUcomp, Inc. also
grants unlimited personal printing rights to the owner, strictly limited to the purposes of not-for-profit
personal or private education or research.

The unauthorized reproduction or distribution of this copyrighted work is illegal. Criminal copyright
infringement, including infringement without monetary gain, is investigated by the FBI and is punishable by
up to five years in federal prison and a fine of $250,000.

Trademark Acknowledgements:

Windows, Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows 10,
Microsoft Word 2003, Microsoft Word 2007, Microsoft Word 2010, Microsoft Word 2013, Microsoft Word
2016, Microsoft Excel 2003, Microsoft Excel 2007, Microsoft Excel 2010, Microsoft Excel 2013, Microsoft
Excel 2016, Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft Access 2013,
Microsoft Access 2016, Microsoft PowerPoint 2003, Microsoft PowerPoint 2007, Microsoft PowerPoint
2010, Microsoft PowerPoint 2013, Microsoft PowerPoint 2016, Microsoft Project 2007, Microsoft Project
2010, Microsoft Project 2013, Microsoft Project 2016, Microsoft Outlook 2003, Microsoft Outlook 2007,
Microsoft Outlook 2010, Microsoft Outlook 2013, Microsoft Outlook 2016, Microsoft OneNote 2003,
Microsoft OneNote 2007, Microsoft OneNote 2010, Microsoft OneNote 2013, Microsoft OneNote 2016,
Microsoft Publisher 2003, Microsoft Publisher 2007, Microsoft Publisher 2010, Microsoft Publisher 2013,
Microsoft Publisher 2016, Microsoft Office 2003, Microsoft Office 2007, Microsoft Office 2010, Microsoft
Office 2013, Microsoft Office 2016, Microsoft Office 365, Microsoft Bing, Microsoft OneDrive, Microsoft
SharePoint, Microsoft Internet Explorer, Microsoft Edge, Microsoft Cortana, Windows Live, Windows
Defender, Windows Exchange Server, Windows Exchange Server Online and Microsoft Security Essentials
are registered trademarks of Microsoft Corporation. Other brand names and product names are trademarks
or registered trademarks of their respective holders.

Disclaimer:

While every precaution has been made in the production of this book, TeachUcomp, Inc. assumes
no responsibility for errors or omissions. Nor is any liability assumed for damages resulting from the use of
the information contained herein. These training materials are provided without any warranty whatsoever,
including, but not limited to, the implied warranties of merchantability or fitness for a particular purpose. All
names of persons or companies in this manual are fictional, unless otherwise noted.Sam

ple
- fo

r e
va

lua
tio

n p
urp

os
es

 on
ly!



3Advanced Project©TeachUcomp, Inc.

Welcome to TeachUcomp, Inc.’s Advanced Project
course. This class continues enhancing the student’s skill
set with using Microsoft Project, one of the most popular
project management programs available today. This class
is designed to give the student with basic knowledge of
Microsoft Project more advanced project management
tools and techniques.

Microsoft Project is a software application that you can
use to manage projects in your organization. It provides an
easy way to enter and track the various project-related
tasks, budget constraints, and the overall project timeline.
You can also produce reports that allow you to track and
manage the project as it is occurring.

Introduction and Overview
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Advanced Task Management

9.1- Setting Task Lead and Lag Time:

You can edit relationship links between tasks in a project file to enter lag time or lead time between
tasks. For example, you could allow a day of lag time to pass between tasks. Alternatively, you could also
allow for lead time, where you begin working on a second task before completing all the work on a first task.
You can edit the duration shown in the “Predecessors” column within the Gantt Chart view of your project
file to enter lead time or lag time for a task.

To add lead time, enter the precedent task reference, followed by the abbreviation for the type of link
that they share. Then enter the value as a negative value to the precedent task reference. For example,
assume you have linked tasks 2 and 3 in a project file with a “Finish-to-Start” task relationship. In the
“Predecessors” column for task 3, you could enter “2FS - 2d,” which would give you a two-day lead time on
the task. You can either enter a specific value or enter the value as a percentage of the task. For example,
entering “2FS - 50%” for task 3 would give you a fifty percent lead time based on the duration of task 2.

To enter lag time, enter the precedent task reference, followed by the abbreviation for the type of link
that they share. Then enter that value as a positive value. For example, assume you have linked tasks 2
and 3 in a project file with a “Finish-to-Start” task relationship. If you enter the value of “2FS + 1d” into the
“Predecessors” column for task 3, you add one day of lag time to the completion of task 2 before starting
task 3. As with lead time, lag time can be entered as either a positive amount or a percentage.

Alternatively, you can enter the lag time and lead time within the “Task Information” dialog box on
the “Predecessors” tab in the “Lag” column. In this case, you enter the amount to increase or decrease into
the field. Entering a positive value adds lag time and entering a negative value adds lead time.

9.2- Using Task Constraints:

All tasks have some type of constraint applied to them. A constraint is simply a scheduling rule that
determines the start or end time of a task, or otherwise controls the scheduling and rescheduling available
for the task. Constraints allow the scheduling engine within Microsoft Project to reschedule tasks, as
needed, within a project file. By default, Microsoft Project creates tasks with flexible constraints to allow for
maximum flexibility in rescheduling. However, you can set the constraints for a task, as desired, to produce
semi-flexible and inflexible constrains when needed.

In Microsoft Project, the available task constraints are grouped into three main groupings: flexible
constraints, semi-flexible constraints, and inflexible constraints. Flexible constraints, which are used for task
scheduling by default, let tasks be scheduled without any date-restrictive limitations, with the exception
being the starting or ending dates of the predecessor and successor tasks in the project file. When you use
a constraint type like “As Soon As Possible (ASAP),” you are using a flexible constraint.

You can also create semi-flexible constraints, which allow for task scheduling within a date boundary
you choose. For example, setting a “Start No Earlier Than” constraint lets a task be scheduled any time
after a specified date has passed. This is an example of using a semi-flexible constraint. You can also
create inflexible constraints. Using inflexible constraints prevents the rescheduling of the task. For example,
using the “Must Start On” constraint forces a task to begin on the date specified. When you specify an
inflexible constraint, the task is never automatically rescheduled for any reason.

In Microsoft Project, you can set the task constraints within the “Task Information” dialog box on the
“Advanced” tab by using the “Constraint type:” and “Constraint date:” drop-down menus. Simply select the
type of constraint to apply from the “Constraint type:” drop-drown and, if necessary, select a date from the
“Constraint date:” drop-down. Click the “OK” button to save the task when you are finished.
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Advanced Task Management

9.3- Task Types:

When you record actual work completed or progress made on a task in a project file, Microsoft
Project recalculates the remaining task duration, by default. When calculating the work value of a task after
updating either the work, duration, or unit values, Microsoft Project uses a formula called the scheduling
formula, to recalculate the task’s remaining work value. The scheduling formula is: Work = Duration x Units.
Note that “Units” refers to the resource assignment units, often entered as a percentage.

When you create tasks in a project file, the task has an associated “Task Type” you can set on the
“Advanced” tab of the “Task Information” dialog box. Each task type corresponds to each element of the
scheduling formula. The task type determines which of the elements in the formula remains constant if one
of the other two elements is changed.

The default task type is “Fixed Units.” Using this task type lets you change the duration of a task to
have Project recalculate the work remaining, or vice versa. However, you can change this setting to either
“Fixed Duration” or “Fixed Work.” If you select “Fixed Duration,” you can change either the work or unit
values and Project recalculates the other value. If you select “Fixed Work,” you can change either the unit or
duration values and Project recalculates the other value. Also note that you cannot disable “effort-driven
scheduling” on a “Fixed Work” task type.

An important point to note is that assigning a task type lets you enter actual work or progress values
for your task and then let Project update the other values. This does not mean you cannot change the
“fixed” value for the task. You can always change any value (duration, units, work) for a task,
regardless of the task type that is applied to the task. The “fixed” aspect simply refers to which element
(variable) in the scheduling equation is held constant when recalculating work values for the task.

9.4- Setting Deadlines:

Many new users of Microsoft Project accidentally make the mistake of using of too many semi-
flexible and inflexible constraints when creating tasks within a project file. This often comes from the urge to
set “Must Finish On” constraints or actual “Finish” dates when creating their tasks. This often produces an
inflexible or semi-flexible constraint on the task. The problem that often occurs when creating tasks in this
manner is that you severely limit the task rescheduling potential of Microsoft Project.

A better way to set deadlines for tasks is to simply set a deadline date for a task and use the default
“As Soon As Possible (ASAP)” constraint. This way, Project can reschedule the task with the greatest
flexibility and you will also be able to view the deadline date for the task in the Gantt Chart.

To set a deadline date for a task, open the “Task Information” dialog box for a selected task and
then click the “Advanced” tab within the “Task Information” dialog box. You then select the desired deadline
date from the “Deadline:” drop-down. Finally, click the “OK” button to set the deadline date for the task.

You should now see a deadline date indicator appear for that task row within the Gantt Chart view of
your project file. If the task is ever scheduled beyond the deadline date, Microsoft Project displays a “Missed
Deadline” indicator for that task in the “Indicators” column in the Gantt Chart view.
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Advanced Task Management

9.5- Interrupting Tasks:

Despite your best efforts in planning, there will inevitably be times when work on a task will be
interrupted. This may be due to an unplanned event or even a task reprioritization. Either way, you can
interrupt work on a task by using the split task function within Microsoft Project. This feature allows you to
split, or interrupt, a task to accommodate planned and unplanned breaks in the work on the task.

To split a task, select the task in the Gantt Chart view in the project file. Then click the “Split Task”
button in the “Schedule” button group on the “Task” tab in the Ribbon. At this point, your mouse pointer icon
changes to the “split task” icon. Place this icon over the date at which you want to split the task in the bar
chart part of the Gantt Chart view. Then click and drag the task to the right to create a split. As you click and
drag, you will see the new “Start Date” shown in a text box called a screen tip. This helps you see the start
date for the second segment of the split task. When the date shown in the screen tip is correct, simply
release the mouse button.

If you dragged the second segment to the wrong date by accident, you can just click and drag the
second segment until the start date of the second segment is on the desired date. This can happen as you
are first learning to split tasks with your mouse. Also note that you can split a task multiple times, as
needed. However, you can only split a task into the smallest increments displayed on the timescale view in
the bar chart area of the Gantt Chart. For example, to split a task by hours, you must ensure the smallest
time increment displayed in the timescale area are hours.

9.6- Moving and Rescheduling Tasks:

In addition to interrupting tasks, you can also reschedule entire tasks in a project by moving them to
a new date. If using “Auto Scheduled” tasks that are linked together, Project asks if you want to move the
related tasks, as well, when you move the initial task within the linked tasks. When you are moving tasks,
always inspect the tasks after you move them to ensure you haven’t broken any task dependencies or
violated any task constraints, like a “Start On” date constraint, for a related task.

To move a task, select the task to move in the “Gantt Chart” view of the project file. Then click the
“Move” drop-down button in the “Tasks” button group on the “Task” tab of the Ribbon. Then select the
direction and duration to move the task from the choices shown in the drop-down menu that appears.

If you select the “Custom” choice, then enter the number of days to move the task either forwards or
backwards into the dialog box that appears and then click the “OK” button to finish moving the task. You
may also see another dialog box that asks you if you want to reschedule any tasks that are related to the
task that you moved. You can select your desired response in this dialog box and then click the “OK” button
to confirm your choice.

To reschedule tasks to the next time resources become available, select the “When Resources are
Available” choice from the drop-down menu. To move parts of a finished task back to a status date or
incomplete parts of a task forward to the next status date, choose either the “Completed Parts to Status
Date” or “Incomplete Parts to Status Date” commands in the drop-down menu.
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Advanced Task Management

9.7- Inspecting Tasks:

You can inspect tasks to display information about the task and task assignment information in a
pane at the left side of the application window. To inspect a task, select the task to inspect in the “Gantt
Chart” view of the project file. Then click the “Inspect” button in the “Tasks” button group on the “Task” tab in
the Ribbon to open the “Task Inspector” pane at the left side of the screen. This pane shows task
information for the selected task, as well as resource assignment and predecessor task information. To turn
off the pane when you are finished inspecting the task information, click the “X” in the upper-right corner of
the “Task Inspector” task pane or click the “Inspect” button within the “Tasks” button group on the “Task” tab
in the Ribbon.

9.8- Creating Recurring Tasks:

Some project tasks can be standard and repetitive, like a weekly project coordination conference
meeting. You can enter these types of tasks as recurring tasks in a project file so you can create the task
once and then have it recur on a regular basis without needing to enter a separate task for each instance of
the task. When you create a recurring task, the tasks that are created all contain a “Start No Earlier Than”
constraint, no task links, and no effort-driven scheduling.

To create a recurring task in a project file, select the blank task line in the Gantt Chart view where
you want to insert the new recurring task. Then click the “Task” drop-down button in the “Insert” button
group on the “Task” tab in the Ribbon. From the drop-down menu that appears, select the “Recurring
Task…” command to open the “Recurring Task Information” dialog box. Type a name for the task into the
“Task Name” field. Then input the duration of the recurring task in the adjacent “Duration” field.

In the “Recurrence pattern” section of the dialog box, set the pattern of recurrence for the task. The
choices shown depend upon whether you set a “Daily,” “Weekly,” “Monthly,” or “Yearly” pattern. After
selecting an option, set the specifics for the option in the area to the right.

In the “Range of recurrence” section, enter the “Start” date of the first instance of the task. To the
right of that, either set the ending date or select the total number of times you want the task to occur. In the
“Calendar for scheduling this task” area, use the “Calendar” drop-down to select the desired working
schedule calendar. When finished, click the “OK” button to save the recurring task.

9.9- Entering Fixed Costs:

You may have fixed costs associated with a task in your project file. A fixed cost is usually a one-
time charge that is needed to accomplish the task. For example, having to pay a permit fee for a
construction project could be an example of a fixed cost.

You can easily enter fixed costs into the “Costs” view of the table in the Gantt Chart view. To do this,
select the task for which you want to enter the fixed costs. Next, click the “Tables” drop-down button in the
“Data” button group on the “View” tab in the Ribbon. From the drop-down menu that appears, select the
“Cost” choice. In the new “Fixed Cost” column that appears next to the tasks, enter the amount to set as a
fixed cost for the task. This total amount is then added to other resource costs in project reports for the task.

To set the table view back to the default “Entry” view, click the “Tables” drop-down button in the
“Data” button group on the “View” tab in the Ribbon. From the drop-down menu that appears, select the
“Entry” choice.
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Advanced Task Management

9.10- Critical Paths:

As used within Microsoft Project, a critical path is the set of tasks that, if delayed, would extend the
end date of a project file. The term “critical,” as used in this context, has nothing to do with the importance of
the task to the overall completion of the project. Rather, it is called a critical task if its delay would extend
the ending date of the project. Therefore, the critical path of a project is the path of tasks within a project file
that cannot be delayed without delaying the entire project deadline.

When dealing with a project that has fallen behind schedule, these are the tasks whose duration
must also be shortened if you are to “bring in” the project’s deadline. The process of shortening the duration
of the critical tasks in the critical path to shorten the project deadline is also called “crashing the critical
path.”

To view the critical path in a project file, switch the view of your project file to the “Tracking Gantt”
view. To switch to the “Tracking Gantt” view, click the “Gantt Chart” drop-down button in the “View” button
group on the “Task” tab in the Ribbon. Then select the “Tracking Gantt” choice from the drop-down menu
that appears.

In the “Tracking Gantt” view, Microsoft Project shows critical task bars in red and noncritical task
bars in blue within the bar chart area. For noncritical tasks, the thin teal line represents the slack time
associated with the task.

9.11- Using WBS Codes:

The term WBS codes stands for Work Breakdown Structure codes. These codes are an outline
numbering automatically applied to tasks by task level when you create them. You can view the default
WBS codes for tasks within the “Advanced” tab of the “Task Information” dialog box. This lesson shows how
to renumber WBS codes and create custom WBS codes in project files.

WBS codes default to being the same as the outline numbering applied to tasks. However, they can
change from this default setting. To see the outline numbers next to the task names in either the “Gantt
Chart” or “Task Sheet” views, click the “Format” tab within the view’s associated contextual tab in the
Ribbon. Then check the “Outline Number” checkbox in the “Show/Hide” button group. To view the actual
WBS codes, you can add the “WBS” column to the selected view.

By default, Project will not renumber the WBS codes within tasks when you move or delete tasks, as
the WBS codes can be linked to other applications outside of Project. That means that if you move or delete
tasks, you will need to manually renumber the tasks within the Project file, if needed.

To create and apply your own custom WBS codes, select the “Define Code…” command from the
drop-down menu that appears when you click the “WBS button” in the “Properties” button group on the
“Project” tab of the Ribbon. In the “WBS Code Definition” dialog box, you can create custom WBS codes for
different task levels within a project file by typing the desired WBS code prefix into the “Project Code Prefix”
text box.

To then set the code for top-level tasks, select a character set from the “Sequence” column in the
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Advanced Task Management

9.11- Using WBS Codes- (cont’d.):

first row of the “Code mask” section. Then set the desired “Length” of the code from the adjacent drop-down
menu and set the desired separator character to use from the adjacent “Separator” column in that row. If
you want to use unique WBS codes for each task level, repeat this process in the second row for second-
level tasks. Continue entering your custom WBS codes for each level until you are done.

If you do not want Project to generate codes automatically, you can uncheck the “Generate WBS
code for new task” checkbox. If you want multiple tasks to potentially share a WBS code, uncheck the
“Verify uniqueness of new WBS codes” checkbox. As most users want Project to automatically generate
unique WBS codes, both of these checkboxes are checked by default. You only need to uncheck them if
you do not want the feature applied. When finished, click the “OK” button to apply the new WBS code
definitions.

To automatically renumber tasks within a project file, switch to the Gantt Chart view or any other
view that lets you see the tasks you want to renumber. You can renumber selected tasks or all tasks within
a project file. To renumber only selected tasks, first click and drag over the tasks to renumber. Note that the
first task you selected, however, will not be renumbered. To renumber all tasks, do not select any tasks at
all.

Next, click the “Project” tab in the Ribbon and then click the “WBS button” in the “Properties” button
group. Then choose the “Renumber…” command from the drop-down menu to open the “WBS Renumber”
dialog box. In this dialog box, select the “Selected tasks” option button to renumber selected tasks or select
the “Entire project” option button to renumber all the tasks in the project file. Then click the “OK” button in
the dialog box to renumber the tasks. If you chose to renumber all project tasks, click the “Yes” button in the
confirmation dialog box that then appears.

Sam
ple

- fo
r e

va
lua

tio
n p

urp
os

es
 on

ly!



12Advanced Project©TeachUcomp, Inc.

ACTIONS-
Advanced Task Management

SETTING LEAD AND LAG TIME:

1. To enter lead time or lag time for a task, you can edit the value shown in the cell of the
“Predecessors” column for the selected task in the Gantt Chart view.

2. To add lead time, enter the precedent task reference followed by the abbreviation for the type of link
they share, and then enter the value as a negative value to the precedent task reference.

3. To enter lag time, enter the precedent task reference followed by the abbreviation for the type of link
that they share, and then enter that value as a positive value.

4. Alternatively, you can enter the lag time and lead time within the “Task Information” dialog box on the
“Predecessors” tab in the “Lag” column, if preferred.

5. Entering a positive value adds lag time and entering a negative value adds lead time.

USING TASK CONSTRAINTS:

1. To set task constraints, open the “Task Information” dialog box and then click the “Advanced” tab
within the “Task Information” dialog box.

2. Select the type of constraint to apply from the “Constraint type:” drop-drown and, if necessary, select a
date from the “Constraint date:” drop-down.

3. Click the “OK” button to save the task when you are finished.

TASK TYPES:

1. To change the task type, open the “Task Information” dialog box and then click the “Advanced” tab
within the “Task Information” dialog box.

2. Use the “Task Type” drop-down to set the desired setting for the task type.
3. The default task type of “Fixed Units” lets you change the duration of a task to have Project

recalculate the work remaining, or vice versa.
4. Alternatively, you can select either “Fixed Duration” or “Fixed Work from the “Task Type” drop-down.
5. If you select “Fixed Duration,” you can change either the work or unit values and Project recalculates

the other value.
6. If you select “Fixed Work,” you can change either the unit or duration values and Project recalculates

the other value.
7. Note that you cannot disable “effort-driven scheduling” on a “Fixed Work” task type.
8. You can always change any value (duration, units, work) for a task, regardless of the task type. The

“fixed” aspect just refers to which element in the scheduling equation is held constant when
recalculating work values for the task.

SETTING DEADLINES:

1. To set a task deadline, open the “Task Information” dialog box for a selected task and then click the
“Advanced” tab in the “Task Information” dialog box.

2. Select the desired deadline date from the “Deadline:” drop-down and click the “OK” button.
3. A deadline date indicator appears for that task row in the Gantt Chart view of the project file.
4. If the task is ever scheduled beyond the deadline date, Microsoft Project displays a “Missed

Deadline” indicator for that task in the “Indicators” column of the Gantt Chart view.
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ACTIONS-
Advanced Task Management

INTERRUPTING TASKS:

1. To split a task, select the task to split in the Gantt Chart view of the project file.
2. Then click the “Split Task” button in the “Schedule” button group on the “Task” tab within the Ribbon.
3. At this point, your mouse pointer icon changes to the “split task” icon.
4. Place this icon over the date at which you want to split the task in the bar chart part of the Gantt Chart

view and then click and drag the task to the right to create a split.
5. As you click and drag, the new “Start Date” appears in a text box called a screen tip. This helps you see

the start date for the second segment of the split task.
6. When the date shown in the screen tip is correct, simply release the mouse button.
7. If you dragged the second segment to the wrong date by accident, you can just click and drag the

second segment until the start date of the second segment is on the desired date.
8. Also note that you can split a task multiple times, as needed. However, you can only split a task into the

smallest increments displayed on the timescale view in the bar chart area of the Gantt Chart. For
example, if you wish to split a task by hours, then you must ensure that the smallest time increment
displayed in the timescale area are the hours.

MOVING AND RESCHEDULING TASKS:

1. To move a task, select the task to move within the “Gantt Chart” view of the project file.
2. Click the “Move” drop-down button within the “Tasks” button group on the “Task” tab in the Ribbon.
3. Select the direction and duration to move the task from the choices shown in the drop-down menu that

appears.
4. If you select the “Custom” choice, enter the number of days to move the task either forwards or

backwards into the dialog box that appears and then click the “OK” button to finish.
5. You may also see another dialog box that asks you if you want to reschedule any tasks related to the

task you moved. You can select your desired response in this dialog box and then click the “OK” button
to confirm your choice.

6. To reschedule tasks to the next time resources become available, select the “When Resources are
Available” choice from the drop-down menu that appears.

7. To move parts of a finished task back to a status date or incomplete parts of a task forward to
the next status date, choose either the “Completed Parts to Status Date” or “Incomplete Parts to Status
Date” commands in the drop-down menu that appears.

INSPECTING TASKS:

1. To inspect a task, select the task to inspect within the “Gantt Chart” view of the project file.
2. Click the “Inspect” button within the “Tasks” button group on the “Task” tab in the Ribbon.
3. That causes the “Task Inspector” pane to appear at the left side of the screen and show task information

for the selected task, as well as resource assignment and predecessor task information.
4. To turn off the pane when you are finished inspecting the task information, click the “X” in the

upper-right corner of the “Task Inspector” task pane or click the “Inspect” button within the “Tasks”
button group on the “Task” tab in the Ribbon.
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ACTIONS-
Advanced Task Management

CREATING RECURRING TASKS:

1. To create a recurring task in a project file, select the blank task line in the Gantt Chart view where
you want to insert the new recurring task.

2. Click the “Task” drop-down button in the “Insert” button group on the “Task” tab within the Ribbon.
3. Select the “Recurring Task…” command from the drop-down menu that appears.
4. Type a name for the task into the “Task Name” field.
5. Set the duration for the recurring task in the adjacent “Duration” field.
6. In the “Recurrence pattern” section of the dialog box, set the pattern of recurrence for the task. The

choices shown depend upon whether you set a “Daily,” “Weekly,” “Monthly,” or “Yearly” pattern. Once
you have selected an option, set the specifics for the option in the area to the right.

7. In the “Range of recurrence” section, enter the “Start” date of the first instance of the task.
8. To the right of that, set the ending date or select the total number of times you want the task to occur.
9. In the “Calendar for scheduling this task” area, use the “Calendar” drop-down to select the desired

working schedule calendar.
10. When finished, click the “OK” button to save the recurring task.

ENTERING FIXED COSTS:

1. To enter fixed costs for a task into the “Costs” view of the table in the Gantt Chart view, select
the task for which you want to enter the fixed costs.

2. Click the “Tables” drop-down button in the “Data” button group on the “View” tab in the Ribbon.
3. From the drop-down menu that appears, select the “Cost” choice.
4. In the new “Fixed Cost” column that appears next to the tasks, enter the amount to set as a fixed cost for

the task. This total amount is then added to other resource costs within project reports for the task.
5. To set the table view back to the default “Entry” view, click the “Tables” drop-down button in the

“Data” button group on the “View” tab in the Ribbon.
6. From the drop-down menu that appears, select the “Entry” choice

CRITICAL PATHS:

1. To view the critical path in a project file, switch the view of your project file to the “Tracking Gantt”
view.

2. To switch to the “Tracking Gantt” view, click the “Gantt Chart” drop-down button in the “View” button
group on the “Task” tab in the Ribbon.

3. Then select the “Tracking Gantt” choice from the drop-down menu that appears.
4. In the “Tracking Gantt” view, Microsoft Project shows critical task bars in red and noncritical task bars in

blue in the bar chart area.
5. For noncritical tasks, the thin teal line represents the slack time associated with the task.Sam
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ACTIONS-
Advanced Task Management

USING WBS CODES:

1. To view the default WBS codes for tasks, open the “Advanced” tab of the “Task Information” dialog
box.

2. WBS codes default to being the same as the outline numbering applied to tasks.
3. To see the outline numbers next to the task names in either the “Gantt Chart” or “Task Sheet”

views, click the “Format” tab within the view’s associated contextual tab in the Ribbon and then check
the “Outline Number” checkbox in the “Show/Hide” button group.

4. To view the actual WBS codes, add the “WBS” column to the selected view.
5. By default, Project will not renumber the WBS codes within tasks when you move or delete tasks, as the

WBS codes can be linked to other applications outside of Project.
6. That means that if you move or delete tasks, you will need to manually renumber the tasks within the

Project file, if needed.
7. To automatically renumber tasks within a project file, switch to the Gantt Chart view or any other

view that allows you to see the tasks that you wish to renumber.
8. To create and apply your own custom WBS codes, select the “Define Code…” command in the drop-

down menu that appears when you click the “WBS button” within the “Properties” button group on the
“Project” tab within the Ribbon.

9. In the “WBS Code Definition” dialog box, you can create custom WBS codes for the different task levels
within your project file by typing the desired WBS code prefix into the “Project Code Prefix” text box.

10. To then set the code for top-level tasks, select a character set from the “Sequence” column in the first
row of the “Code mask” section.

11. Then set the desired “Length” of the code from the adjacent drop-down menu and set the desired
separator character to use from the adjacent “Separator” column in that row.

12. To use unique WBS codes for each task level, repeat this process in the second row for second-level
tasks.

13. Continue entering your custom WBS codes for each level until you are done.
14. To NOT have Project generate codes automatically, uncheck the “Generate WBS code for new task”

checkbox.
15. To allow multiple tasks to potentially share a WBS code, uncheck the “Verify uniqueness of new

WBS codes” checkbox.
16. As most users want Project to automatically generate unique WBS codes, both of these checkboxes are

checked by default. You only need to uncheck them if you do not want the feature applied.
17. To apply the new WBS code definitions when finished, click the “OK” button.
18. To renumber only selected tasks, first click and drag over the tasks that you want to renumber. Note

that the first task that you selected, however, will not be renumbered.
19. To renumber all tasks, do not select any tasks at all.
20. Next, click the “Project” tab within the Ribbon and then click the “WBS button” within the “Properties”

button group.
21. Choose the “Renumber…” command from the drop-down menu to open the “WBS Renumber” dialog

box.
22. In this dialog box, you can select the “Selected tasks” option button to renumber the selected tasks or

you can select the “Entire project” option button to renumber all tasks within the project file.
23. Then click the “OK” button in the dialog box to renumber the tasks.
24. If you chose to renumber all project tasks, click the “Yes” button in the confirmation dialog box that then

appears.
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EXERCISES-
Advanced Task Management

Purpose:

1. To be able to perform advanced task management within a project file.

Exercises:

1. Open the “My Project” project file that contains the saved changes that were made to the file through the
end of the final chapter’s exercises in the “Introductory Project” manual.

2. Click the “Gantt Chart” button in the “View” button group on the “Task” tab within the Ribbon to display
the “Gantt Chart” view for the “My Project” project file, if needed.

3. Select task number 10 (Create review and feedback) in the task list within the Gantt Chart view.
4. Type “7FS + 1d” into the “Predecessors” column for task 10 and be sure to exit the cell to save your

entry. This will add one day of lag time to the selected task.
5. Click the “Save” button in the Quick Access toolbar to save your changes.
6. Select task number 4 (Create evaluative feedback) in the task list within the Gantt Chart view.
7. Click the “Information” button within the “Properties” button group on the “Task” tab in the Ribbon to

open the “Task Information” dialog box for the selected task.
8. Click the “Advanced” tab within the dialog box, and then type “2/10/17” into the “Deadline” text box to set

a deadline date for the task.
9. Click the “OK” button in the dialog box to save your changes to the task.
10. To display the critical path for the project file, click the “Gantt Chart” drop-down button in the “View”

button group on the “Task” tab in the Ribbon.
11. Select the “Tracking Gantt” choice from the drop-down menu that appears.
12. Note the display of the critical path and free slack within the project file.
13. Click the “Gantt Chart” drop-down button in the “View” button group on the “Task” tab in the Ribbon.
14. Select the “Gantt Chart” choice from the drop-down menu that appears to restore the default display of

the project file.
15. Click the “Save” button within the Quick Access toolbar to save your changes.
16. Click the “x” in the upper-right corner of the project file window to close the sample project file that you

just saved. You will continue to use this file to complete the upcoming sequential exercises
throughout this entire course. Each exercise builds upon the previous exercise, so please
complete them in the order given to maximize your overall learning experience.

Sam
ple

- fo
r e

va
lua

tio
n p

urp
os

es
 on

ly!


	Slide Number 1
	Slide Number 2
	Slide Number 3
	Slide Number 4
	Slide Number 5
	Slide Number 6
	Slide Number 7
	Slide Number 8
	Slide Number 9
	Slide Number 10
	Slide Number 11
	Slide Number 12
	Slide Number 13
	Slide Number 14
	Slide Number 15
	Slide Number 16



